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Introduction 
The PowerSchool Web Gradebook is a full featured grade-keeping application used to record, 
report, and modify student performance. 

With PowerSchool’s powerful communication tools, everyone stays connected: Teachers can 
use their gradebook to make decisions on what information they want to share with parents, 
students stay on top of assignments, and parents are able to participate more fully in their 
student’s progress. 

Resources 
There are several resources available to assist you with Web Gradebook. They include Web 
Gradebook Online Help, Web Gradebook User Guide, Web Gradebook Quick Reference Card, 
PowerSchool Customer Support Web site, and PowerSchool Technical Support. 

Web Gradebook Online Help – Coming Soon! 
In Web Gradebook, the Help icon looks like a question mark. Click the Help icon to display 
context-specific help. The help appears in a Web browser. There, you can click the A-Z Index 
tab for an alphabetical list of topics or Topic Index for a list of topics organized by subject. Web 
Gradebook Help is updated as the application is updated.  

Web Gradebook User Guide 
A print-ready version of Web Gradebook online help, the Web Gradebook User Guide, is 
available on the PowerSchool Customer Support Web site. You will need Adobe Acrobat 
Reader to view the user guide. 

Web Gradebook Quick Reference Card – Coming Soon! 
The Web Gradebook Quick Reference Card, which lists tips, tricks, and shortcuts for the most 
frequently used Web Gradebook features, including assignment categories, assignments, 
reports, and shortcuts, is also available on the PowerSchool Customer Support Web site. Keep 
a copy of the quick reference card near the workstation where you use Web Gradebook. 

PowerSchool Customer Support Web Site 
In addition to the Web Gradebook User Guide and Web Gradebook Quick Reference Card, the 
PowerSchool Customer Support Web site provides a wealth of information. To access this site, 
go to https://support.powerschool.com/. 
You will need a username and password to log in. If you do not have a username and 
password, see your PowerSchool administrator.  
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Web Gradebook documentation is located at Support > Pre-Release > Gradebook Beta 
Program. 

PowerSchool Technical Support 
The PowerSchool Technical Support team is comprised of experienced Support professionals 
who have successfully completed advanced product support training. The Support team is 
available to assist you with technical problems, general questions about the PowerSchool 
application, best practices advice, and other product support needs. 

The Technical Support center is staffed Monday through Friday from 4:00 a.m. to 5:00 p.m. 
Pacific Standard Time. 

Telephone Support 

The Technical Support team can be reached by phone at (866) 434-6276. Calls are answered in 
the order they are received. Please have your customer number ready. You will be asked for 
your name to check it against the authorized Technical Contacts allowed for your district. The 
Technical Support team only provides assistance to authorized Technical Contacts. 

Your call will be routed to a Technical Support Specialist. If technical support resources are not 
immediately available, you may follow the prompts to divert your call to voice mail. The voice 
mail queue is checked regularly throughout the business day. The next available Technical 
Support Specialist will return your call. When leaving voice mail, please include your name, 
customer number, phone number where you can be reached, and a brief description of your 
issue. 

Email Support 

You are always welcome to send your questions via email to support@powerschool.com. The 
service level agreement indicates a 24-hour response time to emails (during the normal 
business week).  

Note: One advantage of emailing support is that you have an answer in writing and can archive 
the response for future reference. 

Self-Service 

You may also submit Support cases via the self-service area on the PowerSchool Customer 
Support Web site at https://support.powerschool.com/techsupport/selfservice.do. The self-
service area provides a convenient way to log cases whether you are in your office, at a school 
site, or at another remote location. Through the self-service area, you have the ability to view 
archives of all cases, whether open or closed. 
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Quick Start 
To get started immediately and begin taking advantage of Web Gradebook, perform the 
following tasks to set up and use the application. The following list refers to sections within this 
guide.  

Note: See the respective sections for detailed procedures. For Attendance, see the 
PowerSchool Teacher User Guide. 

Getting Started 

Open Web Gradebook 

The Gradebook Window 

Categories 

Predefined Categories 

Work With Categories 

Assignments 

Work With Assignments 

Publish Assignments 

Final Grades 

Define Final Grade Setup 

Scores and Other Information 

Work With Scores 

Enter Assignment Status 

Work With Score Comments 

Work With Final Grade Comments 

Attendance 

Take Attendance 

View Historical and Future Attendance By Class 

View Historical and Future Attendance By Student 

Quit Gradebook 

Quit Gradebook 
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Getting Started 
To get started, you must log on to PowerSchool Teacher and then launch Web Gradebook. 

Open Web Gradebook 
Web Gradebook is available through PowerSchool Teacher. You will need a username and 
password. If you do not have one, see your System administrator. Once logged in to 
PowerSchool Teacher, note the Web Gradebook link in the main menu. Click this link to launch 
Web Gradebook.  

How to Log On to PowerSchool Teacher 
1. Open your web browser to your school's PowerSchool Teacher URL. The Log On page 

appears. 

2. Enter your username in the first field. 

3. Enter your password in the second field.  

Note: The characters appear as asterisks (*) to ensure greater security when you log in. 

4. Click Enter. The PowerSchool Teacher start page appears. 

How to Launch Web Gradebook for Mac 
1. Click Web Gradebook. The Downloads window appears accompanied by a certificate 

window.  

2. Click Trust. The Java Web Start and Gradebook version windows briefly appear. Then, 
Web Gradebook opens. 

3. Close the Downloads window. 

4. Note the Web Gradebook icon that appears in the dock and the launchGradeBook.jnlp 
file that appears on your desktop. When you quit Web GradeBook, both will be 
discarded automatically.  

How to Launch Web Gradebook for Windows 
1. Click Web Gradebook. The Downloads window appears accompanied by the Warning 

Security window.  

2. Click Run. The Java Web Start and Gradebook version windows briefly appear. Then, 
Web Gradebook opens. 

3. Close the Downloads window. 
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The Gradebook Window 
There are several components to the main window of the Gradebook. These include a menu 
bar, an ID bar, a term selector, the class list, student groups, and a navigation bar. 

The Gradebook window is made of four panes, which are adjustable, both horizontally and 
vertically. To adjust the width of a pane, click and hold the vertical three-line icon and drag right 
or left. To adjust the height of a pane, click and hold the horizontal three-line icon and drag up 
and down. 

Menu Bar 
The menu bar, which appears at the top of the screen, provides a quick way to access the 
various components of Web Gradebook or perform certain functions. The menu bar includes 
options for Gradebook, File, Edit, View, Tools, Window, and Help. The primary options you will 
use are: 

Option Function 

Gradebook Use the Gradebook pull-down menu to set preferences and to quit 
Web Gradebook. 

View Use the View pull-down menu to access the Scoresheet, 
Assignments, Students, Grade Setup, Class Info, and Reports 
windows. 

Tools Use the Tools pull-down menu to set up categories, view 
gradescales, access the Score Inspector, and recalculate final 
scores. 

ID Bar 
The ID bar appears at the top of the GradeBook window and displays your name and the name 
of your school. 

Classes 
The Classes pane appears in the upper left corner of the Gradebook window and includes the 
Term Selector and Class List. The Class List displays a list of your classes for the selected 
term. Use the Term Selector to view classes for a different term. For more information, see 
Classes. 

Student Groups 
The Student Groups pane appears in the lower left corner of the Gradebook window and 
displays student groups for a selected class. For more information, see Student Groups. 
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Navigation Bar 
The navigation bar, which appears at the top of the Gradebook window, provides a quick way to 
access the following areas: 

Tab Function 

Scoresheet Use the Scoresheet window to track assignment scores and view 
student final grades. 

Assignments Use the Assignments window to view, add, edit, and delete 
assignments. 

Students Use the Students window to view class rosters and student 
information. 

Grade Setup Use the Grade Setup window to set up final grades. 

Class Info Use the Class Information window to view class information, as 
well as add, edit, or delete class descriptions. 

Reports Use the Reports window to generate one of five reports, including 
Attendance Grid, Individual Student, Missing Assignment, 
Spreadsheet, and Student Roster. 
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Classes 
The Class List displays a list of your classes for the selected term. 

Select Term 
By default, the current term is selected. Use this procedure to view your classes for a different 
term within the current full year term. 

How to Select a Term 
1. Launch Web Gradebook. The Gradebook appears.  

The first class in your daily schedule appears highlighted. By default, the class 
Scoresheet appears. 

2. Note the term pop-up menu displays for the current term. 

3. Choose a different term from the term pop-up menu. Classes for the term appear. 

Select Class 
By default, the first class in your daily schedule appears highlighted. Use this procedure to 
select a different class. 

How to Select a Class 
1. Launch Web Gradebook. The Gradebook appears.  

The first class in your daily schedule appears highlighted. By default, the class 
Scoresheet appears. 

2. Click a different class. The class Scoresheet appears. 
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Class Information 
The Class Information window displays basic class information, as well as providing a means to 
publish information about the class on the PowerSchool Parent Portal. 

View Class Information 
To view information about a particular class, select the class and click the Class Info tab. 

How to View Class Information 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Class Info tab. The Class Information window displays the following 
information for the class: 

Field Description 

Course Name The name of the class, such as English Composition. 

Term The expression for the class. 

Section Number The section number of the class. 

Periods/Day The period/day combination for the class. 

Start The first day of class. 

End The last day of class. 

Grade Scale The name of the gradescale associated to the class. 

Room The room number for the class. 

Description Detailed information about the class. This information appears 
on the Quick Lookup page in PowerSchool and on the 
PowerSchool Parent Portal. 

Work With Class Description 
When entering a class description, you can use plain text, HTML, or a combination of both. 
Once you enter a class description, it appears on the Quick Lookup page in PowerSchool and 
on the PowerSchool Parent Portal. 

For example: [Plain text] This class focuses upon writing essays for a variety of purposes; 
addressing different audience types; experimenting with different forms of expression; practicing 
techniques for developing and arranging ideas; and building vocabulary, grammar, syntax, and 
related skills.  
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Please refer to the following resources: [HTML describing the resources, showing pictures, and 
links to these sites.] 

How to Add a Class Description 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Class Info tab. The Class Information window appears. 

3. Enter text and/or HTML in the Description field. 

4. Click Save. 

How to Edit a Class Description 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Class Info tab. The Class Information window appears. 

3. Edit the text and/or HTML in the Description field. 

4. Click Save. 

How to Delete a Class Description 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Class Info tab. The Class Information window appears. 

3. Remove the text and/or HTML from the Description field. 

4. Click Save. 
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Students 
The Students window displays a list of students enrolled in a class and basic information about 
each student. 

View Class Roster 
To view the class roster for a particular class, select the class and click the Students tab. 

How to View the Class Roster 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Students tab. The class roster displays the following information for each 
student: 

Field Description 

Student The student’s name. 

Student Number The student’s identification number. 

Birthday The student's date of birth. 

Gender The student’s gender. 

Grade Level The student’s grade level. 

Home Phone The student’s home phone number. 

Filter Class Roster 
By default, the Students window displays students who are currently enrolled in the class. To 
view students with a different enrollments status, use the Filter By function. 

How to Filter the Class Roster 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Students tab. The class roster appears. 

3. Do one of the following: 

• Choose All from the Students Filter By pop-up menu. The class roster 
refreshes and displays students who are both currently enrolled and those who 
are no longer enrolled in the class. 
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• Choose Active from the Students Filter By pop-up menu. The class roster 
refreshes and displays only those students who are currently enrolled in the 
class. 

• Choose Dropped from the Students Filter By pop-up menu. The class roster 
refreshes and displays only those students who are no longer enrolled in the 
class. 

Sort Class Roster 
By default, the Student window displays students in ascending order by name. Using the 
column headings, you can sort data in ascending or descending order based on the column 
heading you select.  

Note: When sorted in ascending order, an upward pointing arrow appears in the column 
heading. When sorted in descending order, a downward pointing arrow appears in the column 
heading. 

How to Sort the Class Roster 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Students tab. The class roster displays students in ascending order by 
student. 

3. Click the Student column heading to sort in descending order. 

4. To sort the class roster by a different column heading, click that column heading. The 
class roster appears in ascending order based on the selected column.  

5. Alternately, click that same column heading to sort the class roster in descending order. 

View Student Details 
To view student details, either double-click the student’s name or click the arrow next to the 
student’s name. 

How to View Student Details 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Students tab. The class roster appears. 

3. Do one of the following: 

• Double-click the student.  

• Click the arrow next to the student.  

The Student Details window displays the following information for the student: 



 BETA Web Gradebook User Guide 

 
Students Copyright © 2007 Pearson Education, Inc or its affiliates. 

All rights reserved. 
19 

 

Field Description 

Alert Discipline, Guardian, or Medical icons appear if an alert exists 
for student. Click an icon to view the alert text. 

First Name The student’s first name. 

Last Name The student’s last name. 

Student Number The student’s identification number. 

Home Phone The student’s home phone number. If using a Mac, click the 
number to view it in large print. 

Gender The student’s gender. 

Grade Level The student’s grade level. 

Birthday The student's date of birth. 

Emergency Contacts The student’s emergency contact information. If using a Mac, 
click the contact information to view it in large print. 

View Alerts 
A student may have one or more of the following alerts: Discipline, Guardian, or Medical. If an 
Alert icon displays for a student, you can view the specific text for the alert. 

How to View Alerts 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Students tab. The class roster appears. 

3. Double-click the student. Student details appear for the selected student. 

4. Click the Discipline, Guardian, or Medical icon to view the alert text. The alert window 
appears. 

5. Click OK to close the alert window. 
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Student Groups 
Students arrive on the first day of school with different needs and levels of readiness. Using 
student groups, you can adapt instruction to the particular needs of students. 

Student groups are made up of a hierarchical structure; a set, groups within that set, and 
students within those groups. Student groups are class-specific. Therefore, you will need to 
create student groups for each class you want to apply grouping to. 

Work With Sets 
The first step to creating student groups is to create a set. Remember that the class, for which 
you are creating student groups, must be selected. Once you have created the sets you want, 
then you can create groups for those sets. 

How to Create a Set 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. In the Student Groups pane, click the Plus (+) button. 

3. Choose Set. The untitled set appears as an editable text field. 

4. Enter the name of the set. 

5. Press ENTER or RETURN to save your changes. 

How to Rename a Set 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. In the Student Groups pane, double-click the set you want to rename. The set appears 
as an editable text field. 

3. Update the field as needed.  

4. Press ENTER or RETURN to save your changes. 

How to Delete a Set 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. In the Student Groups pane, select the set you want to delete. The set appears 
highlighted. 

3. Click the Minus (-) button. A confirmation window appears. 

4. Click Yes to delete. 
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Work With Groups 
Once you have created a set, you can then add one or more groups to that set. Again, 
remember that the class, for which you are creating student groups, must be selected.  Once 
you have created the groups you want, then you can add students to those groups. 

How to Create a Group 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. In the Student Groups pane, select the set you want to add a group to. The set appears 
highlighted. 

1. Click the Plus (+) button.  

2. Choose Group. The untitled group appears as an editable text field. 

3. Enter the name of the group. 

4. Press ENTER or RETURN to save your changes. 

How to Rename a Group 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. In the Student Groups pane, click the expanding arrow next to the set that contains the 
group you want to rename. The groups belonging to the set appear. 

3. Double-click the group you want to rename. The group appears as an editable text field. 

4. Update the field as needed.  

5. Press ENTER or RETURN to save your changes. 

How to Move a Group 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. In the Student Groups pane, click the expanding arrow next to the set that contains the 
group you want to move. The groups belonging to the set appear. 

3. Select the group you want to move. The group appears highlighted. 

4. Drag and drop the group into the new set.  

How to Delete a Group 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. In the Student Groups pane, click the expanding arrow next to the set that contains the 
group you want to delete. The groups belonging to the set appear. 

3. Select the group you want to delete. The group appears highlighted. 

4. Click the Minus (-) button. A confirmation window appears. 
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5. Click Yes to delete. 

Work With Students 
Once you have created a set and one or more groups within a set, you can then add students. 

How to Add Students to a Group 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. In the Student Groups pane, click the expanding arrow next to the set that contains the 
group you want to add students to. 

3. Select the group. The group appears highlighted. 

4. Click the Students tab. The class roster appears. 

5. Press and hold COMMAND (Mac) or CONTROL (Windows) as you click each student 
you want to add to the group. 

6. Drag and drop the students into the group.  

How to Move Students from Group to Group 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. In the Student Groups pane, click the expanding arrow next to the set that contains the 
group you want to move students from. The set appears highlighted. 

3. Click the expanding arrow next to the group that contains the students you want to 
move. The group appears highlighted. 

4. Press and hold COMMAND (Mac) or CONTROL (Windows) as you click each student 
you want to move. 

5. Drag and drop the students into the new group.  

How to Remove Students from a Group 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. In the Student Groups pane, click the expanding arrow next to the set that contains the 
group you want to remove students from. The set appears highlighted. 

3. Click the expanding arrow next to the group that contains the students you want to 
remove. The group appears highlighted. 

4. Select each student you want to move. 

5. Click the Minus (-) button. A confirmation window appears. 

6. Click Yes to delete. 
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Categories 
Before you can create assignments, you must set up categories. Categories are groups of the 
same types of assignments. Categories are not class-specific, eliminating the need to create the 
same categories multiple times for each class.  

Predefined Categories 

By default, Web Gradebook includes four pre-defined categories, Homework, Project, Quiz, and 
Test. 

View Categories 
To view categories, you do not need to select a class. Simply navigate to the Categories 
window using the Gradebook menu bar. 

How to View Categories 
1. From the Gradebook menu bar, choose Tools > Categories. The Categories window 

appears. A list of categories appears on the left side of the window. If necessary, use the 
scroll bar to view the entire list of categories. 

2. Select a category. Detailed information for the category appears on the right of the 
window. The following information displays for each category: 

Field Description 

Name The category name. 

Abbreviation The category abbreviation. 

Color The color assignments in this category appear as on the 
Scoresheet and Assignments windows. 

Points Possible The default number of points possible for assignments in this 
category. 

Score Type The default method by which assignments in this category are 
recorded. 

Include in Final 
Grade 

The default option for inclusion in final grade calculation for 
assignments in this category. 

Description Detailed information about the category. 

Note: For more information, see How to Add a Category. 
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Work With Categories 
You can create, edit, or delete multiple categories prior to closing the Categories window. 

How to Add a Category 
1. From the Gradebook menu bar, choose Tools > Categories. The Categories window 

appears. 

2. Click the Plus (+) button in the lower left corner of the Categories window. The new 
category appears on the left side of the window. 

3. Use the following table to enter information into the fields: 

Field Description 

Name The category name. 

Abbreviation The category abbreviation. 

Color Use the pop-up menu to choose the color assignments in this 
category appear as on the Scoresheet and Assignments 
windows. 

Points Possible Enter the default number of points possible for each assignment 
in this category.  

You can modify this information for individual assignments as 
needed. 

Score Type Use the pop-up menu to choose the default method by which 
assignments in this category should be recorded: Points, 
Percentage, or Letter Grade.  

You can modify this information for individual assignments as 
needed. 

Include in Final 
Grade 

Select this checkbox to include assignments in this category 
when calculating final grades.  

You can modify this information for individual assignments as 
needed. 

Description Enter the description of the category using plain text, HTML, or 
a combination of both. This information appears on the Quick 
Lookup page in PowerSchool and on the PowerSchool Parent 
Portal when an assignment using this category is published. 

For example: [Plain text] This category is worth 20% of the 
student’s grade. Homework assignments are due every Monday 
and are worth 10 points each. Students are allowed to miss only 
one. Missing more than one assignment may significantly affect 
the student’s over-all grade.  
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Field Description 

Please refer to the following resources: [HTML describing the 
resources, showing pictures, and links to these sites.] 

4. Click OK to save your changes. The Categories window closes. 

How to Edit a Category 
1. From the Gradebook menu bar, choose Tools > Categories. The Categories window 

appears. 

2. Select the category you want to edit. The category details appear. 

3. Edit information as needed. For field descriptions, see How to Add a Category. 

4. Click OK to save your changes. The Categories window closes. 

Note: You may want to delay clicking OK until you have completed all of the edits you 
want to make for each of the categories. Otherwise, you will have to access the 
Categories window from the Gradebook menu bar again. 

How to Delete a Category 
1. From the Gradebook menu bar, choose Tools > Categories. The Categories window 

appears. 

2. Select the category you want to delete. 

3. Click the Minus (-) button in the lower left corner of the Categories window. The 
Categories window appears without the deleted category. 

4. Click OK to save your changes. The Categories window closes. 
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Assignments 
Once you have set up categories and organized students into groups, you can then create 
assignments. You can create one assignment at a time as you progress through the term, or 
you can set up assignments for the entire term before the term starts. 

Having all assignments for the term before the term starts does not change how grades appear. 
The Final Grade that appears on the Scoresheet reflects an average grade for only the 
assignment scores that have been entered. 

Before setting up an assignment, consider how you will score the assignment. Do you want to 
record the score as points, a percentage, or letter grade? How many points is the assignment 
worth? How do you want to weight the assignment? Do you want to include the assignment in 
final grade calculation? 

Weighting 

Assignment setup may involve weighting; however, weighting is not required. Weighting gives 
particular assignments, whether points, percentage, or letter grades, more value than others 
when determining final grades. The weight value is used to multiply the points earned and the 
points possible. For assignments that you will be weighting, you must select the Include in 
Final Grade checkbox. 

View Assignments 
To view assignments for a particular class, select the class and click the Assignments tab. 

How to View Assignments 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Assignments tab. The Assignment window appears. The following information 
displays for each assignment: 

Field Description 

Name The assignment name. 

Abbreviation The assignment abbreviation. 

Category The category the assignment is grouped by. 

Points Possible The number of points possible for the assignment. 

Weight The weight of the assignment. 

Date Due The date the assignment is due. 

Note: For more information, see How to Add an Assignment. 
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Filter Assignments 
By default, the Assignments window displays assignments for all categories for the entire length 
of the class. To view assignments for a different reporting term or category, use the Filter By 
function. 

How to Filter the Assignments 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Assignments tab. The Assignment window appears. 

3. Do one or both of the following: 

• Choose a term from the Filter By Reporting Term pop-up menu. The 
Assignment window refreshes and only displays assignments for the selected 
term. 

• Choose a category from the Filter By Category pop-up menu. The Assignment 
window refreshes and only displays assignments for the selected category. 

Sort Assignments 
By default, the Assignment window displays assignments in ascending order by name. Using 
the column headings, you can sort data in ascending or descending order based on the column 
heading you select.  

Note: When sorted in ascending order, an upward pointing arrow appears in the column 
heading. When sorted in descending order, a downward pointing arrow appears in the column 
heading. 

How to Sort Assignments 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Assignments tab. The Assignment window displays the assignments in 
ascending order by name. 

3. Click the Name column heading to sort in descending order. 

4. To sort assignments by a different column heading, click that column heading. 
Assignments appear in ascending order based on the selected column.  

5. Alternately, click the same column heading to sort assignments in descending order. 

Work With Assignments 
You can add, edit, or delete assignments from both the Assignments window and the 
Scoresheet window. 
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How to Add an Assignment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Scoresheet or Assignments tab. The Assignment window appears. 

3. Click New Assignment. The New Assignment window appears. 

4. Use the following table to enter information into the fields: 

Field Description 

Name Enter the assignment name. 

Abbreviation Enter the assignment abbreviation. 

Category Use the pop-up menu to choose the category by which the 
assignment should be grouped.  

Score Type If a Category is selected, the score type defaults to the 
category score type. 

Use the pop-up menu to choose the method by which the 
assignment should be recorded: Points, Percentage, or Letter 
Grade. 

Points Possible If a Category is selected, the points possible defaults to the 
category points possible. 

Enter the number of points possible for the assignment. 

Weight Enter the weight of the assignment. The system multiplies both 
the assignment's points possible and the students' scores by 
this weight when calculating final grades. 

Date Due Enter the date the assignment is due using the format 
mm/dd/yyyy, or click the Calendar icon and select the date. 

Include in Final 
Grade 

If a Category is selected, this checkbox defaults based on the 
category. 

Select this checkbox to include this assignment in final grade 
calculation. 

Description Enter the description of the assignment using plain text, HTML, 
or a combination of both. This information appears on the Quick 
Lookup page in PowerSchool and on the PowerSchool Parent 
Portal when the assignment is published. 

For example: [Plain text] Analyze and write 500 word essay on 
Herman Melville’s Billy Bud. What point is the author trying to 
make? Support your idea with several aspects of the story - 
plot, characterization, setting, irony, symbolism, imagery, etc. 
Show how these different aspects work together to convey the 
message.  
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Field Description 

Please refer to the following resources: [HTML describing the 
resources, showing pictures, and links to these sites.] 

5. To make the assignment visible to parents, go to Step 4 of How to Show an Assignment. 

How to Edit an Assignment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Scoresheet or Assignments tab. The Assignment window appears. 

3. Double-click the assignment you want to edit. The assignment details appear. 

4. Edit information as needed. For field descriptions, see How to Add an Assignment. 

5. To make the assignment visible to parents, go to Step 4 of How to Show an Assignment. 

6. Otherwise, click Save. 

How to Delete an Assignment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Scoresheet or Assignments tab. The Assignment window appears. 

3. Select the assignment you want to delete. The assignment details appear. 

4. Click Delete Assignment. The Delete Assignment window appears. 

5. Click Yes. The assignment no longer appears on the Assignment window. 

Publish Assignments 
Once you enter an assignment, the assignment and assignment scores appear on the Quick 
Lookup page in PowerSchool. In order for parents and students to view this information on the 
PowerSchool Parent Portal, you will need to publish it.  

When publishing an assignment, you also have the option to publish the assignment score. 
Alternately, if you do not want make an assignment available on the PowerSchool Parent Portal, 
you can elect to never publish the assignment. 

How to Show an Assignment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Scoresheet or Assignments tab. The Assignment window appears. 

3. Select the assignment you want to publish. The assignment details appear. 

4. Click Publish. 

5. From the Publish Assignment pop-up menu, choose when to publish the assignment: 
Immediately, On Specific Date, Days Before Due, or On Due Date. 
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6. If you selected On Specific Date, enter the date the assignment should appear in the 
Date On field using the format mm/dd/yyyy, or click the Calendar icon and select the 
date. 

7. If you selected Days Before Due, enter the number of days the assignment should 
appear prior to the date that it is due in the Days Before Due field. 

8. Click Save. 

How to Hide an Assignment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Scoresheet or Assignments tab. The Assignment window appears. 

3. Select the assignment you do not want published. The assignment details appear. 

4. Click Publish. 

5. Choose Never from the Publish Assignment pop-up menu. 

6. Click Save. 

How to Show Assignment Scores 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Scoresheet or Assignments tab. The Assignment window appears. 

3. Select an assignment. The assignment details appear. 

4. Click Publish. 

5. Select the Publish Scores checkbox. 

Note: If the Publish Assignment pop-up menu is set to Never, do not select this 
checkbox. 

6. Click Save. 

How to Hide Assignment Scores 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Scoresheet or Assignments tab. The Assignment window appears. 

3. Select an assignment. The assignment details appear. 

4. Click Publish. 

5. Deselect the Publish Scores checkbox. 

6. Click Save. 
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Gradescales 
You can view details about a gradescale, or view the gradescale that is associated to a class. 

View Gradescales 
You can view all gradescales or those associated with a specific class. 

How to View Gradescales 
1. From the Gradebook menu bar, choose Tools > Gradescales. The Gradescales 

window displays the following information for each gradescale: 

Field Description 

[Gradescales] The gradescales provided by your school. 

Name The name of the selected gradescale. 

Grade The letter grade. 

Cutoff The percentage cutoff for the grade. 

Percent The percent value assigned to the grade. 

Description Description for the grade. 

2. Click Close when done viewing. 

How to View a Gradescale Associated to a Class 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Class Info tab. The Class Information window appears. 

The name of the gradescale associated to this class appears in the Grade Scale field. 
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Final Grades 
Using a combination of options, you can control how Final Grades are calculated in your 
classes. Final Grade Preferences apply to all of your classes while Final Grade Setup applies to 
a specific class and must be setup within each class. 

Define Final Grade Preferences 
Use the Preferences window to define how you want final grades to appear in Web Gradebook, 
either rounded or truncated. You can also indicate the number of decimals you want to appear. 

How to Define Final Grade Preferences 
1. From the Gradebook menu bar, choose Gradebook > Preferences. The Preferences 

window appears. 

2. To indicate how you want final grades to be calculated, select the appropriate When 
calculating a grade the value should be option: 

• Rounded: Rounds the number up or down to the nearest decimal point specified. 

• Truncated: Cuts off the number at the specified number of places after the 
decimal. 

3. Choose the number of digits to appear after the decimal point from the Store calculated 
grades with up to pop-up menu. 

4. Click OK to save your changes. 

Define Final Grade Setup 
Use final grade setup to specify how you want final grades to be calculated for students in your 
classes. 

Final Grades and Categories 

When setting up categories, you can use the Include in Final Grade checkbox indicate whether 
assignments within a category should be included when calculating final grades. For more 
information, see Categories. 

Final Grades and Assignments 

When setting up assignments, you can use the Include in Final Grade checkbox indicate 
whether assignments should be included when calculating final grades. For more information, 
see Assignments. 
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Weighting 

Final grade setup may involve weighting; however, weighting is not required. Weighting gives 
particular assignments, categories, or terms more value than others when determining final 
grades. The weight value is used to multiply the points earned and the points possible. 

 

How to View Reporting Terms 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Grades Setup tab. The Grades Setup window displays the following reporting 
term information for your school: 

Field Description 

Reporting Term The name of the term. 

Start The first day of the selected term. 

End The last day of the selected term. 

How to Calculate Final Grades by Total Points 
The total points method calculates final grades based on how many points a student has 
accumulated over the term divided by total points possible. 

1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Grades Setup tab. The Grades Setup window appears. 

3. Click the name of the reporting term you want to set up final grade calculation for.  

Note: Calculate Final Grade Using options are based on the selected term. 

4. Select the Total Points option for Calculate Final Grade Using. 

5. Enter the number of low scores you want to drop from the final grade calculation in the 
Number of low scores to discard field. 

6. Click Save. 

How to Calculate Final Grades by Term Weight 
The term weight method calculates final grades based on the total points times the value (or 
weight) of each term or assignment. 

1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Grades Setup tab. The Grades Setup window appears. 

3. Click the name of the reporting term you want to set up final grade calculation for. 

Note: Calculate Final Grade Using options are based on the selected term. 
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4. Select the Term Weights option for Calculate Final Grade Using. Terms for the 
selected Reporting Term appear. 

To add a term: 

1. Double-click the term’s Weight field. The field appears as an editable text field. 

2. Enter the weight.  

3. Press TAB, RETURN (Mac) or ENTER (Windows). 

4. Repeat for each additional term. 

5. Click Save. 

To add an assignment: 

1. Click Add Assignment. The Select Assignment window appears. 

2. Select the checkbox of the assignment you want to add. 

3. Click OK. The assignment appears on the Grades Setup window. 

4. Double-click the assignment’s Weight field. The field appears as an editable text field. 

5. Enter the weight. 

6. Click Save. 

7. Repeat for each additional assignment. 

To remove an assignment: 

1. Select the assignment you want to delete. The assignment appears highlighted. 

2. Click Remove. 

3. Click Save. 

How to Calculate Final Grades by Category Weight 
The category weight method calculates final grades based on total points times the value (or 
weight) of each category or assignment. 

1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click the Grades Setup tab. The Grades Setup window appears. 

3. Click the name of the reporting term you want to set up final grade calculation for. 

Note: Calculate Final Grade Using options are based on the selected term. 

4. Select the Category Weights option for Calculate Final Grade Using. 

To add a category: 

1. Click Add Category. The Select Category window appears. 

2. Select the checkbox next to the category you want to add. 

3. Click OK. The category appears on the Grades Setup window. 

4. Double-click the category’s Weight field. The field appears as an editable text field. 
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5. Enter the weight. 

6. Double-click the category’s Drop Low field. The field appears as an editable text field. 

7. Enter the number of low scores you want to drop from the final grade calculation. 

8. Click Save. 

9. Repeat for each additional category. 

To add an assignment: 

1. Click Add Assignment. The Select Assignment window appears. 

2. Select the checkbox of the assignment you want to add. 

3. Click OK. The assignment appears on the Grades Setup window. 

4. Double-click the assignment’s Weight field. The field appears as an editable text field. 

5. Enter the weight. 

6. Click Save. 

7. Repeat for each additional assignment. 

Manually Override Final Grades 
In some cases, you may need to override a calculated final grade for a student. When overriding 
a calculated grade, you can set a unique value for both Percent and Letter Grade. 

How to Manually Override Final Grades 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Open Score Inspector. The Score Inspector window appears. 

3. Select the final grade of the student you want to update. The final grade field appears 
highlighted. The assignment details appear in the Score Inspector window. 

4. Select the Manual Override checkbox. 

5. Enter the new final grade in the Score field. 

6. Enter final grade text in the Comment field, if applicable. 

7. Use the Previous and Next arrows to repeat for each student, if applicable. 

8. Click Close to save. The final grade appears within the selected student final grade field. 
If a commented was entered, a blue circular “C” also appears. 

Recalculate Final Scores  
Recalculate Final Scores is a special function that is used as a final option when there is a 
question as to the accuracy of a final grade.  

BETA: More commonly, however, Recalculate Final Scores should be used when 
administrators change certain data that will impact final grade calculations. Any change that is 
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made to a Gradescale for a section such as the actual assigned Gradescale or a modification to 
one or more Grades within a Gradescale will not be reflected in Gradebook until Recalculate 
Final Scores is selected. 

How to Recalculate Final Scores 
From the Gradebook menu bar, choose Tools > Recalculate Final Scores. The Gradescales 
window appears. 
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Scoresheet 
The Scoresheet window is where you will probably spend most of your time. Using the 
Scoresheet window, you can create and score assignments and view final grades for students 
in your classes.  

Assignment, Category, and Student filters are included so you can control what data is 
displayed.  

The details pane of the Scoresheet may be used to view details for either assignments or 
students depending on the need. 

View Scoresheet 
To view assignments and scores for a particular class, select the class and click the Scoresheet 
tab. 

How to View the Scoresheet 
1. Select a class from the Classes pane. The class Scoresheet displays the following 

information: 

Field Description 

Student The student’s name. 

Final Grade The student’s final grade. 

[Assignments] Assignments for this class and grades and comments received 
the assignments. 

Filter Scoresheet 
By default, the Scoresheet window displays view assignments and scores for all categories for 
students enrolled in the current full year term. To view assignments and scores for students with 
a different enrollments status or for a different reporting term or category, use the Filter By 
function. 

How to Filter the Scoresheet 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Do one or more of the following: 

• Choose a term from the Filter By Reporting Term pop-up menu. The 
Scoresheet refreshes and only displays assignments and scores for the selected 
term. 
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• Choose a category from the Filter By Category pop-up menu. The Scoresheet 
refreshes and only displays assignments and scores for the selected category. 

• Choose an enrollment status from the Filter By Students pop-up menu. The 
Scoresheet refreshes and only displays assignments and scores for students 
with the selected enrollment status. For more information, see Filter Class 
Roster. 

View Assignment Statistics 
The Summary section of the Scoresheet provides statistical information for each assignment. 
When selecting an assignment, the mean, median, and mode for that assignment appear. 

The mean is the mathematical average of the scores you entered. The median represents the 
middle of all values: one-half of the scores will be above this number and one-half will be below 
it. The mode indicates the most common value. 

All of these values are indicators of how well your students did on the assignment. If any one of 
them is unexpectedly low, it may be that students need additional practice on the skills and 
concepts being assessed, or the assessment needs to be revised. 

How to View Assignment Statistics 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Select an assignment. 

3. Click Summary. The mean, median, and mode appear for the selected assignment. 

The Points Earned appears in the lower right corner of the Scoresheet. When a final 
grade or assignment is selected, the total points earned to date appear. 

Enter Assignment Status 
You can enter assignment status directly on the Scoresheet window or using the Score 
Inspector. For more information, see Score Inspector. 

How to Mark an Assignment as Collected 
Use this procedure to indicate that an assignment for a student has been collected. When 
marked as collected, a green checkmark appears within the selected student assignment field. 

1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click in the assignment column of the student you want to enter an assignment status 
for. The assignment field appears highlighted in red. 

3. Press SHIFT+click (Mac) or ALT+click (Windows) and select Collected. The 
assignment status appears on the Scoresheet. 



 BETA Web Gradebook User Guide 

 
Scoresheet Copyright © 2007 Pearson Education, Inc or its affiliates. 

All rights reserved. 
39 

 

How to Mark an Assignment as Late 
Use this procedure to indicate that an assignment for a student is late. When marked as late, a 
red circular “L” appears within the selected student assignment field. 

1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click in the assignment column of the student you want to enter an assignment status 
for. The assignment field appears highlighted in red. 

3. Press SHIFT+click (Mac) or ALT+click (Windows) and select Late. The assignment 
status appears on the Scoresheet. 

How to Mark an Assignment as Exempt 
Use this procedure indicate that an assignment for a student is exempt. An exempted 
assignment will appear one of two ways depending on whether or not a score is entered for the 
student for the assignments. If no score is entered and the assignment is marked as exempt, an 
italicized “Ex” appears in the score cell. If a score is entered and the assignment is marked as 
exempt, the score will be italicized and will be a light grey color. 

1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Click in the assignment column of the student you want to enter an assignment status 
for. The assignment field appears highlighted in red. 

3. Press SHIFT+click (Mac) or ALT+click (Windows) and select Exempt. The assignment 
status appears on the Scoresheet. 

Work With Scores 
You can enter, edit, or delete scores directly on the Scoresheet window or using the Score 
Inspector. For more information, see Score Inspector. 

How to Enter a Score 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Double-click the assignment column of the student you want to enter a score for. The 
assignment field appears as an editable text field. 

3. Enter the score. 

4. Press TAB, RETURN (Mac) or ENTER (Windows). The score appears on the 
Scoresheet as the cursor advances to the next field. 

How to Edit a Score 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Double-click the score you want to edit. The assignment field appears as an editable text 
field. 
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3. Enter the new score. 

4. Press TAB, RETURN (Mac) or ENTER (Windows). The new score appears on the 
Scoresheet as the cursor advances to the next field. 

How to Delete a Score 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Double-click the score you want to delete. The assignment field appears as an editable 
text field. 

3. Do one of the following: 

• Highlight the score and press DELETE. 

• Press SHIFT+click (Mac) or ALT+click (Windows) and select Clear Score. 

4. Press TAB, RETURN (Mac) or ENTER (Windows). The score no longer appears on the 
Scoresheet as the cursor advances to the next field. 
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Score Inspector 
The Score Inspector provides and alternative way of entering scores and other information. 
Once you open the Score Inspector window, it floats above the Scoresheet window. You may 
want to move it to a convenient location on your desktop, so you can work with the Scoresheet. 
The Score Inspector remains open until you choose to close it. 

Open Score Inspector 
You can open the Score Inspector from the Gradebook menu bar or directly within the 
Scoresheet window. 

How to Open Score Inspector 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Do one of the following: 

• From the Gradebook menu bar, choose Tools > Score Inspector. The 
Scoresheet Inspector window appears. 

• From any assignment field (or Final Grade field) within the Scoresheet, press 
SHIFT+click (Mac) or ALT+click (Windows) and select Score Inspector. The 
Scoresheet Inspector window appears. 

View Assignment Details 
You can view assignment details on the Score Inspector window. 

How to View the Scoresheet 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears 

3. Click in the assignment column of the student you want to assignment information for. 
The assignment field appears highlighted in red. The assignment details appear in the 
Score Inspector window: 

Field Description 

Student The name of the selected student. 

Note the arrows next to the student name. Click the Next arrow 
to move to the next student (within the Scoresheet). Click the 
Previous arrow to move to the previous student (within the 
Scoresheet). 
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Field Description 

Assignment The name of the selected assignment.  

Note the arrows next to the assignment name. Click the Next 
arrow to move to the next assignment (within the Scoresheet). 
Click the Previous arrow to move to the previous assignment 
(within the Scoresheet). 

Score Type Indicates how the assignment is recorded: Points, Percentage, 
or Letter Grade. 

Collected Indicates whether an assignment for a student was collected. 

Late Indicates whether an assignment for a student was turned in 
late. 

Exempt Indicates whether an assignment for a student is exempt. 

Score The score earned by the student for the selected assignment. 
Entry must match the score type: Points, Percentage, or Letter 
Grade. 

Points Points earned and points possible based on score entered. 

Percent Percentage based on score entered. 

Grade Letter grade based on score entered. 

Comment Detailed information about the assignment score. 

View Final Grade Details 
You can view final grade details on the Score Inspector window. 

How to View Final Grade Details 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears 

3. Click in the final grade column of the student you want to view final grade information for. 
The final grade field appears highlighted in red. The final grade details appear in the 
Score Inspector window: 

Field Description 

Student The name of the selected student. 

Note the arrows next to the student name. Click the Next arrow 
to move to the next student (within the Scoresheet). Click the 
Previous arrow to move to the previous student (within the 
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Field Description 

Scoresheet). 

Reporting Term The reporting term for the selected final grade. 

Manual Override Indicates if manual override of a final grade is enabled. 

Percent Percentage based on score entered. 

Grade Letter grade based on score entered. 

Points Points earned and points possible based on score entered. 

Comment Detailed information about the final grade. 

Enter Assignment Status 
You can enter assignment status using the Score Inspector or directly on the Scoresheet 
window. For more information, see Scoresheet. 

How to Mark an Assignment as Collected 
Use this procedure to indicate that an assignment for a student has been collected. When 
marked as collected, a green checkmark appears within the selected student assignment field. 

1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears 

3. Click in the assignment column of the student you want to enter an assignment status 
for. The assignment field appears highlighted in red. The assignment details appear in 
the Score Inspector window. 

4. Select the Collected checkbox. The assignment status appears on the Scoresheet. 

5. Click Close to save.  

How to Mark an Assignment as Late 
Use this procedure indicate that an assignment for a student is late. If marked as late, a red 
circular “L” appears within the selected student assignment field. 

1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears 

3. Click in the assignment column of the student you want to enter an assignment status 
for. The assignment field appears highlighted in red. The assignment details appear in 
the Score Inspector window. 

4. Select the Late checkbox. The assignment status appears on the Scoresheet. 

5. Click Close to save.  
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How to Mark an Assignment as Exempt 
Use this procedure indicate that an assignment for a student is exempt. An exempted 
assignment will appear one of two ways depending on whether or not a score is entered for the 
student for the assignments. If no score is entered and the assignment is marked as exempt, an 
italicized “Ex” appears in the score cell. If a score is entered and the assignment is marked as 
exempt, the score will be italicized and will be a light grey color. 

1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears 

3. Click in the assignment column of the student you want to enter an assignment status 
for. The assignment field appears highlighted in red. The assignment details appear in 
the Score Inspector window. 

4. Select the Exempt checkbox. The assignment status appears on the Scoresheet. 

5. Click Close to save.  

Work With Scores 
You can enter, edit, or delete scores using the Score Inspector or directly on the Scoresheet 
window. For more information, see Scoresheet. 

How to Enter a Score 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears. 

3. Select the assignment of the student you want to update. The assignment field appears 
highlighted in red. The assignment details appear in the Score Inspector window. 

4. Enter the score in the Score field.  

5. Use the Previous and Next arrows to repeat for each student, if applicable. 

6. Click Close to save. The score appears on the Scoresheet. 

How to Edit a Score 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears. 

3. Select the assignment of the student you want to update. The assignment field appears 
highlighted in red. The assignment details appear in the Score Inspector window. 

4. Enter the new score in the Score field.  

5. Use the Previous and Next arrows to repeat for each student, if applicable. 

6. Click Close to save. The new score appears on the Scoresheet. 
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How to Delete a Score 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears. 

3. Select the assignment of the student you want to update. The assignment field appears 
highlighted in red. The assignment details appear in the Score Inspector window. 

4. Highlight the score and press DELETE.  

5. Use the Previous and Next arrows to repeat for each student, if applicable. 

6. Click Close to save. The score no longer appears on the Scoresheet. 

Work With Score Comments 
When entering a score comment, you can use plain text, HTML, or a combination of both. Once 
you enter the score comment, it appears on the Quick Lookup page in PowerSchool. In order for 
parents and students to view this information on the PowerSchool Parent Portal, you will need 
to publish it. For more information, see Publish Assignments. 

How to Add a Score Comment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears. 

3. Select the assignment of the student you want to update. The assignment field appears 
highlighted in red. The assignment details appear in the Score Inspector window. 

4. Enter the score text in the Comment field. 

5. Use the Previous and Next arrows to repeat for each student, if applicable. 

6. Click Close to save. A blue circular “C” appears within the selected student assignment 
field. 

How to Edit a Score Comment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears. 

3. Select the assignment of the student you want to update. The assignment field appears 
highlighted in red. The assignment details appear in the Score Inspector window. 

4. Edit the score text in the Comment field. 

5. Use the Previous and Next arrows to repeat for each student, if applicable. 

6. Click Close to save. A blue circular “C” appears within the selected student assignment 
field. 
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How to Delete a Score Comment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears. 

3. Select the assignment of the student you want to update. The assignment field appears 
highlighted in red. The assignment details appear in the Score Inspector window. 

4. Highlight the comment text in the Comment field and press DELETE. 

5. Use the Previous and Next arrows to repeat for each student, if applicable. 

6. Click Close to save. The blue circular “C” no longer appears within the selected student 
assignment field. 

Work With Final Grade Comments 
When entering a final grade comment, you can use plain text, HTML, or a combination of both. 
Once you enter the final grade, it appears on the Quick Lookup page in PowerSchool. In order 
for parents and students to view this information on the PowerSchool Parent Portal, you will 
need to publish it. For more information, see Publish Assignments. 

How to Add a Final Grade Comment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears. 

3. Select the final grade of the student you want to update. The final grade field appears 
highlighted in red. The final grade details appear in the Score Inspector window. 

4. Enter the final grade text in the Comment field. 

5. Use the Previous and Next arrows to repeat for each student, if applicable. 

6. Click Close to save. A blue circular “C” appears within the selected student final grade 
field. 

How to Edit a Final Grade Comment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears. 

3. Select the final grade of the student you want to update. The final grade field appears 
highlighted in red. The final grade details appear in the Score Inspector window. 

4. Edit the final grade text in the Comment field. 

5. Use the Previous and Next arrows to repeat for each student, if applicable. 

6. Click Close to save. A blue circular “C” appears within the selected student assignment 
field. 
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How to Delete a Final Grade Comment 
1. Select a class from the Classes pane. The class Scoresheet appears. 

2. Open the Score Inspector. The Score Inspector window appears. 

3. Select the final grade of the student you want to update. The final grade field appears 
highlighted in red. The final grade details appear in the Score Inspector window. 

4. Highlight the comment text in the Comment field and press DELETE. 

5. Use the Previous and Next arrows to repeat for each student, if applicable. 

6. Click Close to save. The blue circular “C” no longer appears within the selected student 
assignment field. 
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Reports 
The Gradebook contains a selection of reports to assist you in daily classroom activities, as well 
as with assessing student performance. 

Attendance Grid 
The Attendance Grid report lists all students and provides an area to take attendance quickly 
and easily. 

How to Run the Attendance Grid Report 
1. Click the Reports tab. The Reports window appears. 

2. Click Attendance Grid. The Attendance Grid window appears. 

3. Use the following table to enter information in the fields: 

Field Description 

Output Type Select the option indicating the format in which you want to 
receive the report: 

• PDF 
• HTML 
• Export 

Sections Select the option indicating the sections for which you want to 
run the report: 

• Selected Class 
• Active Class 

Students Select the option indicating the students for which you want to 
run the report: 

• Enrolled Students 
• Selected Student Group(s) 

Current Week Select this checkbox to run the report for the current week. 
Note the Start Date and End Date fields become populated 
with this week’s date range. 

Start Date To run the report for a date range other than this week, enter 
the start date for the date range using the format mm/dd/yyyy. 

End Date To run the report for a date range other than this week, enter 
the end date for the date range using the format mm/dd/yyyy. 
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4. Click Run Report. The Save dialog appears. 

5. Enter a file name for the report and the location where you want to save the report. 

6. Click Save. 

7. To view the report, navigate to where the report was saved and open it. 

Individual Student Report 
The Individual Student report provides assignment scores and final grade information for one 
student at a time. 

How to Run the Individual Student Report 
1. Click the Reports tab. The Reports window appears. 

2. Click Individual Student Report. The Individual Student Report window appears. 

3. Use the following table to enter information in the fields: 

Field Description 

Output Type Select the option indicating the format in which you want to 
receive the report: 

• PDF 
• HTML 
• Export 

Sections Select the option indicating the sections for which you want to 
run the report: 

• Selected Class 
• Active Class 

Students Select the option indicating the students for which you want to 
run the report: 

• Enrolled Students 
• Selected Student Group(s) 

Start Date Enter the start date for the date range using the format 
mm/dd/yyyy. 

End Date Enter the end date for the date range using the format 
mm/dd/yyyy. 

4. Click Run Report. The Save dialog appears. 

5. Enter a file name for the report and the location where you want to save the report. 

6. Click Save. 
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7. To view the report, navigate to where the report was saved and open it. 

Missing Assignment Report 
The Missing Assignments report displays which students lack which assignments. 

How to Run the Missing Assignment Report 
1. Click the Reports tab. The Reports window appears. 

2. Click Missing Assignment. The Missing Assignment window appears. 

3. Use the following table to enter information in the fields: 

Field Description 

Output Type Select the option indicating the format in which you want to 
receive the report: 

• PDF 
• HTML 
• Export 

Report Layout Select the option indicating how the missing assignments 
should appear on the report: 

• By Student 
• By Assignment 

Sections Select the option indicating the sections for which you want to 
run the report: 

• Selected Class 
• Active Class 

Students Select the option indicating the students for which you want to 
run the report: 

• Enrolled Students 
• Selected Student Group(s) 

Start Date Enter the start date for the date range using the format 
mm/dd/yyyy. 

End Date Enter the end date for the date range using the format 
mm/dd/yyyy. 

4. Click Run Report. The Save dialog appears. 

5. Enter a file name for the report and the location where you want to save the report. 

6. Click Save. 
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7. To view the report, navigate to where the report was saved and open it. 

Spreadsheet Report – Coming Soon! 
The Spreadsheet report helps you create a spreadsheet-style report of all assignments, 
assignment categories, grades, and other class information. 

How to Run the Spreadsheet Report 
1. Click the Reports tab. The Reports window appears. 

2. Click Spreadsheet. The Spreadsheet window appears. 

3. Click Run Report. The Save dialog appears. 

4. Enter a file name for the report and the location where you want to save the report. 

5. Click Save. 

6. To view the report, navigate to where the report was saved and open it. 

Student Roster – Coming Soon! 
The Student Roster report creates class rosters using the parameters you define. You can 
choose the information to include on the roster. 

How to Run the Student Roster 
1. Click the Reports tab. The Reports window appears. 

2. Click Student Roster. The Student Roster window appears. 

3. Click Run Report. The Save dialog appears. 

4. Enter a file name for the report and the location where you want to save the report. 

5. Click Save. 

6. To view the report, navigate to where the report was saved and open it. 
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Quit Gradebook 
When you are finished working in Web Gradebook, it is important to quit the application, which 
you can do from any window in the application. Additionally, when you are finished working in 
PowerSchool Teacher, it is important to log out, which you can do from any page in the system. 

How to Quit Web Gradebook 
1. From the Gradebook menu bar, choose File > Save.  

2. From the Gradebook menu bar, choose Gradebook > Quit Gradebook. 

3. If the Gradebook is in the middle of saving information, a window appears notifying you 
that changes are being saved. Please wait while the Gradebook finishes saving 
changes. 

How to Log Out of PowerSchool Teacher 
1. Click Logout in the navigation bar. The Log On page appears. You must enter your 

username and password again to redisplay the PowerSchool Teacher start page. 
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Frequently Asked Questions 
 

Can some teachers be on the Web Gradebook and others continue to use PowerGrade? 
Yes. We recognized the possible need for this usage. Therefore, the Gradebook type is 
selectable by teacher. 

 

Can a teacher use both PowerGrade AND Web Gradebook at the same time? 
No. If PowerGrade is the selected Gradebook for a teacher, the Web Gradebook cannot be 
launched from PowerTeacher. If Web Gradebook is selected, any data that a teacher tries to 
send from PowerGrade is blocked from being processed by PowerSchool server. 

 
Is Gradebook type a school-by-school setting or teacher-by-teacher? 
The Gradebook type selection can be set on a teacher-by-teacher basis. You can switch 
multiple teachers at once. For more information, see How to Enable for a Selection of Teachers 
in the Web Gradebook Installation Guide. 

 

What happens if a teacher starts a term using PowerGrade and then switches to Web 
Gradebook after assignments and scores have been entered for enrolled students? 
For Web Gradebook BETA, data from PowerGrade is NOT migrated to Web Gradebook. When 
a teacher begins work in Web Gradebook, it will appear as if no assignments/scores have been 
created for a section. This will be a future enhancement. 


